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Hello,

My name is Mike Board. | must admit | have tried every multimedia application there is. While
Director is an excellent program it was a little more than | needed. Also having a fulltime job did not
afford me the hours needed to fully access the program. | have also tried and used - Multimedia Fusion,
Authorware, llluminatus, NeoBook and others and while each has it its own unique features | have
come to fall in love with the easy to use and powerful program called MultiMedia Builder. The support is
excellent and the helpful userbase cannot be beat. If the problem can be solved it is because of its
professional, helpful users. Add the price of the program to the ticket ( extrememely low ) and the
continual added features by its author and you have a product that is incredibly hard to beat.

The reason this document came to be was to make available to myself a manual about MultiMedia
Builder and secondly, to teach myself more about the production of Adobe Acrobat PDF format files.
The problem with a helpfile is that it is not portable and | suspect many of us have not fully acclimated
themselves to this format of instruction. | grew up in the library and read everywhere | go. | find printed
material the best way for me to learn while on or offline. Acrobat files cross both lines - they can be read
while online or printed for offline reading.

This manual is comprised of:

1.)  The helpfile that comes with MultiMedia Builder - this the helpfile from version 3.2f.

2.)  The tips posted at The MultiMedia Builder Discussion Board - | have included tips at the
end of this manual that | extracted from the Discussion Board and will time to time post
new additions in .pdf format as the Board grows. All you will need to do is print the latest
addendum and add it to the back of this manual and you will have a very helpful piece of
information. Your knowledge of MMB will increase very quickly.

| realize there are corrections to be made, but overall you should find this very helpful.

Mike Board - Mike in Texas
pathways@door.net
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Introducing Multimedia Builder

Creating professional interactive multimedia applications is easier than ever!

If you need to develop creative multimedia projects without having to spend months learning how to use authoring
software - Multimedia Builder (MMB) — the visual multimedia authoring tool — is for you.

You can create FAST and SIMPLE:
Autorun CD browsers (menus) for corporate CD-ROMs

Autorun CD browser provides a graphic interface (GUI) for your CD-ROM files and, product setup. It makes the setup
process easy and more enjoyable. Impress your customers by using graphics, video and sound in your applications! Market
other applications by providing product information within the CD browser. Provide contact information for your company, E-
mail and link to your website.
Tutorials
Cue Cards
Kiosk or Exhibition Stands
Product Presentations
Toolbars
Media Players
and
much more

The limit is your imagination!

Powerful And Easy!

No scripting or programming required.

MMB visual click-to-create object oriented environment makes it easy to create professional multimedia applications in
minimal time and at low cost.

MMB integrates text, graphics, sound and video objects.

Actions can execute programs, play sounds, videos, jump to web sites, browse CD ROMs, display documents, Help files,
send E-mail... and much, much more.

About The Author

Believe it or not MMB is my hobby project. | am developing it in the evenings and weekends at my home using a Pentium
133 and terrible 14" monitor. Why | started making my own multimedia program ? What do we have for creating autorun
menus for our software or front-end for Mixed-mode audio CD’s in reasonable price? There are many authoring tools on the
market. Some of them are really good, but you don’t want to spend $1000 to create autorun menu or CD browser. Some of
them are cheaper, but you don’t want to spend a month to learn how to use it. | started making MMB just for myself, to be
able in 30 minutes create professional looking autorun browser. And here it is! It couldn’t be done without help of other
people on the internet | never met.

So, What Is MMB?

It's an authoring tool with great features and one of the best price in the industry! It is great for small projects, autorun menus,
cd browsers, multimedia applications for Mixed-mode CD’s, toolbar applications etc. However, if you going to make Encarta
size multimedia, you should invest a bit more. Yet, you can create an autorun for it!

Happy Authoring!
Oscar



How To Contact Us

Email: oscar@mediachance.com

Please don’t send any attachments, ask me first.You are dealing with a “real person,” not a large company, so no titles
are necessary when contacting me.

Also, check our Web Site for upgrades: www.mediachance.com

Extended List Of Features

WYSIWYG design (What You See Is What You Get)

Object Oriented environment

Click-to-create objects and actions

Smart script language (you can still make projects without any script!)
Support all popular graphic formats

Multiple Undo/Redo

Grouping and Ungrouping objects, nested grouping, add to groups
Alignment tools

Blend graphics with background

Alpha Transparency Masks for blending

Multiple sound channels

Full MP3 support

24-bit color

Optimized performance

Real Glow and Drop Shadow

Visual Effects: Sharpen, Blur, Flip

Background Bitmap Tiling

Background sound can play across page boundaries, looping
Embedded wave

Embedded MOD

Layered Objects

Create your own graphic buttons, save, load to/from library

Move away from rectangular windows! Support custom shapes and library — tracing from image
Paste graphics directly from your image editor to MMB without saving
Play video at any speed

Fade out effect

Wizard for objects and actions

Create Standalone projects

Powerful Compression

Timer

Animated GIFs

Optional full screen background

Bargain price

Version Changes

3.3a - Current Version

Version 3.1
* Print Text Function
* Page Import/Export

* Bitmap Button has new option ‘Auto-Button’ - This allows you to create bitmap button only from one
Image. The button will have look and feel like Text Button but with a bitmap.
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* Video Object has the option to load MPEG, VideoDisc or MOV - using MCI - this saves some writing in script for MCI.
* OctaMed sound support (*.med). Thsi is the first from upomming mod formats.
* OpenFile command and internal <File> added. This allows you to pop-up Open File dialog
For Example: OpenFile(“MPEG files |*.mpg]|”,”*.mpg”)
Then you can use the <File> (the same way like you were using <SrcDir>). For MCI you can use -
For Example: MCICommand(“play <File>")
* VolumeUp and VolumeDown commands were added
* Custom Shape window: The B/W Mask option was added allowing you to create any shape even with holes The candy See
Through was added. This will turn the background of project transparent and then you can cast shadow on desktop or make
fully semitransparent window. However it has some limitation.
* Cover Windows task bar in Full Screen background option.
Version 3.0
* Animated Gif support.
* Embedded Waves.
* Midi.
* MCI commands (allows you to play MPEG or video disc.)
* For-next loop.
Version 2.0
* Full MP3 support with feedback.
* Script language with variables.
* Timer functions (NextPageafter, ExitAfter.)
Version 1.3
New Object - Paragraph Text
Paragraph text with word wrap and scroll bar.
Master page and Master Top Layer
CD Audio or Mixed-Mode CD support.
For those who wish to write their own CD-ROM, and have access to a recordable CD drive. In version 1.3, each page can
play different audio tracks from the CD. Great for the Mixed-mode custom CD - on track 1 you have your programs, MMB
player and data, and on other tracks you can put audio songs.
Objects can play Tracks from CD Audio.
In the Sounds Actions you can write into the On Click box commands for CD Audio:
CD:2 - will play second track
CD:STOP - Stop Playing
CD:PLAY - Play
CD:PAUSE - Pause
CD:FW - play next song

CD:BW - play prev. song
CD:PLP - Play/Pause



You can easily create a simple CD player now. (See CDAudio.mbd sample)
Selection preview.

See exactly how the selected object will look.

To open/close selection view: Click on the large button at the bottom of Object List.
Preview allows you to see hidden objects, groups, and much more.

For lots of graphics which slows down the design process, switch off the preview!
(It goes into the groups, etc., so it may slow down the designer.)

Stand Alone compiler is now part of the designer.

In the External Commands and page actions - “Minimize” function was added.
Version 1.2

Improved Object List

The group object can expand (tree like) to show objects (or groups) in this group. You get the following advantages:

You can refine the position of the object in the group without ungrouping it. Expand the group in the object list,
select the desired object, and refine the position with the keyboard arrows.

You can remove the object from the group and move it outside. See Remove from Group.
You can delete objects inside the group without ungrouping it
Better Tracker

The tracker - rectangle around the selected object was sometimes jumping to the wrong position.
(If you open any dialog box) and now it is also visible on the black background.

Bug fix - DropShadow and Glow

This bug was caused when resizing the rectangle of the bitmap, and inserting a drop shadow or glow.

Bug fix - change Label inside the group.

If you changed the Label of the object inside a group, the objects appeared unselectable or even invisible.
The Remove all effects in the menu Effects was renamed to Restore original.

New - Add new Actions in “Interactive with other objects” for Mouse Click on the object.
Show/Hide

Show an object or a group. This will stay until an object hides it.
Hide an object or a group. This will stay until an object shows it.

Invert (Show-Hide)
Show or Hide an object or a group. If the object is hidden, this will show it and vice-versa.
Those actions allow the creation of nice effects like menus etc. See NewMenu.mbd sample.

Note: One object can show/hide a nested group (Group1) inside another group (Group2). Another object can show/hide this
group (Group2)... There is a lot of logic inside. See the demo.
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New - Add to Group

In order to add an object to an existing group select the object, hold down the SHIFT key, and select the desired group. Click
Add to the Group button or from menu Arrange select Add to Group.You can also add a group into another group the same
way, but remember to select first the object you want to add and then the group where you want to place the object.

New - Remove from Group

You can remove (ungroup) single object from the group. Select the object inside the group in the Object list, and press
Remove from Group button.

New - Scalable Bitmap Objects

Bitmap objects are now scalable. If you resize the bitmap object the image will resize as well. You can return the image to
the original anytime (even after you save), just by clicking Restore Original from Effects menu.

Note: After you resize the image all effects (sharpen, blur, flip, gray scale) will be removed. This is because MMB s trying
to make the new resized image with the best possible quality. To preserve the ratio, hold down Control when resizing.

New - Tile. (menu Effects)

After you resize the image you can apply this effect. If the new image is bigger than the original, the image will be tiled to the
size of new image. If the new size is smaller the image will be cropped.

Note: If you resize the image again the tile effect will be removed.
New - Reduce size

Resizing bitmaps and applying effects will create temporary bitmaps inside the project. Those bitmaps are not necessary for
distributing and removing them can significantly reduce the size of the project.

Project Settings

Window Size Shows the Width and Height of the application window.
Window Title The title (caption) appears at the top of the Standard Window.
Standard Window If checked, the window of your application will be a standard window — with caption,

border and close button. If unchecked, the window will be a custom window — no border,
caption or close button are displayed. Also, you can create and use your own artwork.

Client Border A thin black border will be drawn in the window’s client area. Very good if you need to
add a thin border to the window without any border (unchecked Standard Window).

See Through This is a new feature — with this the background will be turned into transparent. Like that
you can create objects casting shadows on the desktop, or windows with semi-
transparency soyou can “See Through”. This is absolutely different from the Custom
Shape window. However this feature has few limitations:

- windows cannot be Always on Top

- the moving is not smooth and it can create some disturbances — so the best will
be to use it for some non movable splash screens

Custom Shape Window This unique feature moves MMB’s Non Standard window even further. The window can
have a custom shape — taken from a library or an image.



Trace Shape

From Image

Black / White Mask

If 256 Colors Detected

To work properly, the image must be on solid background with

enough space around. Specify the start point (where the tracer will start.) It should be in
the background of the image. The tracer tolerance allows you to specify a closer shape.
“0” value: no tolerance. For maximum effect, create your background artwork on a solid
background. Then, create the shape with the tracer, and use the same image for the
background.

You can use another option — B/W mask. The white part will be invisible (transparent)
and the black color will become a window. With the B/W Mask you can create windows
with custom shape with holes. This is the difference between B/W Mask and the Tracer.
Tracer only outline the picture. B/W Mask allows you to create any shape you like. (The
same ay like WinAmp is using Skins.)

With the runtime, if MMB detects 256 color it can run another page (not the first one),
run another file, or just continue. On the separate page (or file), optimize graphics to
display 256 colors.

Palette Note: Only for 256 colors.

Graphics MMB

Windows Standard

Style
Always On Top

Save Last Position
In Registry

Background Mode

Optimized palette for most full-color pictures. Use this palette when creating pictures or
images. Extract the palette in the Palette directory (palette.bmp) using your graphic
editor, and then apply it on all images.

Windows standard palette is recognized by all graphics applications. Use it whenever
your projects deal with screen captures.

Put the active window on the top of all windows — topmost window.

Applications generated by MMB remember its last position which is stored in registry
under a specified name. The next time you run it, it will open in the same position.
Remember to use a different name in the edit box in order to store the position of your
applications. Otherwise, they will share the same position.

Tip: Use it for toolbars and launchers applications.

Use this mode to hide the desktop with a specific background.

Tip: Use it to create application for kiosk or exhibition stands. It's also great for creating
Autorun Browsers where the background use an image in relation to the project.

In Background Mode, chose Solid Fill (select the color), or use an image (load it with
load button.) Then, specify how it will be displayed:

Normal: Top-left corner of the screen.
Tile: Tile the chosen image.
Stretch: Stretch image to full screen.
Tip: The last option allows you to create very interesting presentations.
Chose pictures with patterns which could be stretched nicely. Don’t use small pictures,

pictures with text. Use a standard display ratio like 4:3 — for example, 640 x 480 is
adequate for most screens. Corel products installation offers some nice examples.
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Disable Alt-Tab In Win95

How To Work With Objects

Group Manager

Group

Create A Group
Of Objects

Ungroup Objects

Add Objects
To Group

Remove Objects
From Group

Group Object

Great for kiosks where you don’t want a user to switch from one app to another. It also
disables Ctrl-Alt-Del, and other windows commands. It doesn’t disable Esc. You have to
handle it otherwise.

Tip: To disable Esc, use CBK_EXIT.

Select objects by their name, and assemble them into a group

Grouping is effective for protecting and maintaining connections and relations between
objects. Group command lets you lock objects together to create a single object. You can
select any grouped objects to move, copy or hide them.

How to create a group of objects:

1.) Select all the objects you want in the group.

2.) Choose Group from the Arrange menu (or CTRL+G) to create the group.

How to ungroup objects:

1.) Select the group.

2.) Choose Ungroup command from Arrange menu (or CTRL+U).

Within the group, you still have access to the properties of each object through Group
Properties. The group command also lets you create nested groups — groups composed
of objects or groups of objects. To select and group an object by its name, use the Group
Manager command.

Tip: Group objects together if you want to prevent accidental changes to related objects.
To add an object to an existing group:

1.) Select the object, hold down SHIFT, and select the desired group.

2.) Click Add to Group button, or from menu Arrange select Add to Group.

Also, a group can be added to another one the same way,. First, remember to select the
object you want to add, and the group where you want to place the object.

You can remove (ungroup) single objects from the group.
1.) Select the objects inside the group in the Object list.
2.) Press Remove from Group button.

Group object is a group containing objects. Open the Group properties tohave access to
the grouped objects or other nested groups.

Tip: Double click on an object to see its properties.

If you Hide the group, all objects within the group will also be hidden.



Align Object Multimedia Builder provides controls to align any series of objects. Use align tools to line up your
objects precisely (left, right, top, or bottom.)

To align objects, select those you want to align:
1.) Click to select the first object.

2.) Hold down the Shift key, and select the next object.

3.) Repeat until all objects are selected
OR
1.) Click near and outside the objects to be aligned. As you drag thecursor, a

rectangle appears.
2.) Hold and drag the mouse around the objects, and release it.

You can use any of the alignment tools.

CBK Objects - These are special feedback objects.

CBK_Total

CBK_Time

CBK_MP3Type

CBK_MP3Bit

CBK_MP3Freq

CBK_MP3NameFile

CBK_MP3EOF

CBK_Menu

CBK_EXIT

If any text object has this Label then the total time from MP3 file will be displayed here.
Make sure you create the text object with enough space around it to accommodate the
number format XX:: XX

Displays the current time of playing MP3 file.

The type of current MP3 file (MPEG 1 Layer 3)

BitRate of current MP3

Frequncy of current MP3

Name of current MP3

For Example see macmp3_2.mbd

If any script on the current or Master Top layer page has the label CBK_MP3EOF, the
script will be executed when the current playing MP3 ong ends up. If there is no such
script with this label on current page, MMB will look into Master Top Layer, if even there
is no such script, the song will just end and that’s all. There could be anything in the
CBK_MP3EOF script - you can put there NextPage and the MMB will go to the next
page when mp3 file reach its end, you can Show some picture, you can open another
MP3 song...

Use this to create a Menu group you want to hide if the user clicks away from the group.
Instead of using hotspots around the menu, make the label of the group starting with
CBK_Menu. Whenever the user clicks on the screen, all objects starting with CBK_Menu
will be hidden, except themenu under the cursor.

Use this to catch the Close button on the title bar or the Escape key.

Note: The object or group MUST be in the Master Top layer.

Whenever the user press Escape or click on the Close button, the CBK_EXIT object will

be shown. You create the CBK_EXIT group on a Master Top layer with a background
rectangle.



Insert the text: «Do you want to exit?»

And two buttons: «OK» and «Cancel».

If the user clicks on OK: Trigger the Exit action.

If the user clicks on Cancel: Hide the CBK_EXIT group .

How To Work With Pages

Page Properties A page is the place where you design your multimedia project.
Label

It's the name of the page. A label is a unique string of text which represents a page, or can be called
upon by an action.

Background
A page can have a solid background defined by a color. It can also be a bitmap background. To load a
Bitmap as a background, press the Load Image button. If the image is smaller than the page size you

can Tile the image.

Tip: You can find some pretty interesting background in the directory Background. They can be tiled for
exciting effect.

You can copy all graphic properties included in the first page to any other subsequent pages. The back
ground graphics are very important. Put as much graphics as you can into the background. Redrawing
the background is much faster than any other objects. You can combine objects with background.

Combine Objects With Background

1.) Select the objects you would like to combine.

2.) From the menu Arrange, select Combine — Objects with background.

3.) From the next dialog, select Delete source objects, and Use this image to create a new back
ground.

A page can use the background included in the first page, or from the Master Page.
Background Music

MMB can play different background music on each page. The music can play across page boundaries. If
the next page has no background music, the last one will continue playing. You can loop music. You can
find music on the Internet, or on CD’s like Corel Stock Music Library. You can select to play MP3 file on
page start. This doesn’t go through multichannel sound. You can use embedded waves as well — just
write the Internal Name of the embedded wave file.

Digital Audio

MMB can play audio tracks from CDs. A track can start playing as soon as a user enters a page. Use
this function to build your Mixed-mode CD where the first track is a data track (your player and MBD data
file and other data), and the other tracks are audio tracks. Mixed mode CDs are widely used for games
and multimedia, because playing audio tracks doesn’t take much resources like playing WAVE files.



Script

You can trigger any actions or change variables using Script language.

Note: Background music plays through the DirectSound channel. It's mixed with other sound effects
without interruption. The user must have DirectSound which is installed on almost 95% of the systems.
(In the future it will be 100%, since Win95 SP 2 and Windows98 have DirectSound by default.) MMB
allows you to create Distribution Files, and can detect the system of the user. In the worst case (user
without DirectSound), a user will not be able to hear background music, but he will be able to hear Sound
Actions, which are played through standard audio output.

Master Page Properties

A Master Page can have a background. (The same as a “regular page”.) To use a Master Page back
ground on another page, check Background — From Master Page on the desired page properties. Other
wise the page will have its own background or the one from the first page.

Master Page and Master Top Layer

Note: This is a very important feature for project with many pages.

Don’t copy common objects to all pages, which is a waste of space. Instead, put common objects on the
Master Page or Master Top Layer.

What's the difference?
Master Page

Will appear as a bottom layer on each page. The objects on the page will appear all the time on the top
of the objects from the Master Page.

Tip: Great to insert your artworks. You can also insert interactive objects, but make sure no other objects
cover them.

Master Top Layer

Will appear as a top layer on each page. The objects on the page will be behind the Master Top Layer
objects.

Tip: Great for active objects like menus, buttons, windows, etc.
Add Comments To Project
From the menu File — Comments...You can add comments to your project. If you want this window to

open automatically after you open the project in designer, check the check box «show next time on
Open».

How To Work With Text

Text Button

You can create standard Window button. It can have different fill and color. It behaves like a standard
windows button...

Actions

Text button is an active object all of the time.
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To build a custom Menu Groups, assign a style to the Text Button Objects.
Text Properties

Texts are an integral part of any multimedia design. Use text objects to display headlines, body text or
any other words that will be displayed on the screen.

Tip: Text can be active or inactive.
Label

Unique string representing the object. Use this name to interact with other objects. Hide: Hide
object. The object will not be visible for the viewer, and no object actions will be triggered.

Font

Open the font dialog box.

Align

Align the text Left, Center or Right.
Enable The Actions

Enable the object to trigger some actions.
Color Interaction

If actions are enabled, text can change color when the mouse moves over or user clicks on the
text.

Note: For longer texts and paragraphs use the Paragraph Text object instead
Paragraph Text

The Paragraph Text object has automatic word-wrapping (scrollable) for long text. Drag the text rectangle on the
screen and the text will fill the rectangle.

Note: If the text is longer than the visible rectangle, the Scroll Bar will appear.

Tip: A user can scroll the text two ways: by dragging the scroll bar, or by clicking on the text and moving the
mouse up or down. ( The cursor will transform into a hand.)

How To Work With Images And Graphics

Animated Gifs

Animated Gifs are very common on Internet. You can get thousands of gifs just browsing the net or buying a not
expensive clipart CD. You can work with ANIGIFS like with any other objects — grouping them, moving them in
layers, etc. Experiment with the settings! This is not all what you can do with the anigif! If you Show anigif in your
actions - anigif start animate from the first page, if you Hide it it dissapear. In script you can control more:
AGifPlay(“ANIGIF OBJECT”)

Play gif (for example if autoplay feature is off)

AGifStop(“ANIGIF OBJECT”)

1"



Stop , the next play will continue from this frame

AGifReset(“ANIGIF OBJECT”)

Reset - set the first frame

Note: Anigifs takes more CPU than static pictures. You can use Anigifs in layers - be careful - the alpha transpar
ent bitmaps takes more time to redraw - if you overlap Anigif and some Alpha transparent bitmaps - the gif will
slow down. Don’t try to put too much on one page ! The anigifs are great for highlighting something special.

Label String represents the new object.
Info
Frames
Number of frames in the gif (gif must have more than 1 frame to be animated)
Disposal
There are few types of animated gifs using different optimization — the number bigger than 0
shows the gif is using one of the optimization (keeping the first frame and showing only differ
ences, keeping the prev. frame ...)
Speed
Frame rate
The rate in ms (the time between the frames) , it is the rate of first frame — other frames can
have different rate
Adjust
Adjust the frame rate by percent (200% 2-times slower).
Note: Speeding up the animation doesn’t have to have a desired effect all the time.
Example: you have Frame rate 10 ms, you adjust the speed 50% (5 ms). No effect ! The 5 ms is
not enough for the computer to redraw the frame. (Even the 10 ms is not enough!)
Background

Color

This is the color retrieved from the gif marked as a background color However you can select
another color to be a background - this will allow you to turn almost any gif into the transparent

gif.

Transparent

Make the selected color transparent - sometimes if you see the result very strange - select other
background color (for example the gif is on white background, but the background color was
retrieved

Auto Play

Automatically start playing the gif on Show or page start.
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Tile

You have to resize the gif first (make it bigger) and then click this option. This will let you to
create animated patterns. Not all gifs are good for this functions - you cannot use transparent
option.

Loop

The gif will loop the animation

Hide after last frame

This will hide the gif after last frame was displayed - good for showing some nimation which will
hide itself on the end.

Bitmap Object
Bitmap object can be active or inactive.

Bitmap object can be built from two parts: Image and Transparency Map (Alpha transparency). Primitive
objects can be active.

Rectangle

It can be filled, with a border (Line), without a border (None), or using a windows border — raised or
sunken.

Circle
Uses the same properties as the rectangle object.
Polygon

With this version of MMB the polygon has very limited functionality — it cannot be resized, but it can have
a different fill and border, or no border at all.

Note: You can make bitmap object interactive by inserting some actions.
Tip: Nice multimedia applications can be created just by using the primitive objects and text!
Clone

Clone object will inherit all graphic properties from its parent, but it can have different actions. If you change the
parent, all clone objects will change the same way.

For example, you create the bitmap button and then clone another five objects out of it. If you later load other
bitmaps into the parent, all other five objects will change the look. Clone tool can save space, but it is a bit
slower to redraw.

Line

Line is an inactive object. It can not have an action.
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Bitmap Button

You can create custom graphic buttons out of 3 images.

1)) The normal Image
2.) The Highlighted image if mouse is moved over the button
3.) The Click Image if the mouse is clicked on the button.

Auto-Button

This allows you to create bitmap button only from one (Normal) image. The button will have look of Windows
button — with your image. You need to load only the Normal Image.

Refine Bitmap Position

You can change the relative position of the highlight and click image to the normal image: To get soft delightful
effect or if the images don’t have the same origin.

All of the images can have one transparent color.

The color box will help you to define the background color with Automatic color. It is the top left pixel of the
image.

You can save your buttons and make your own library for easy access later.
Bitmap buttons are an essential part of all large graphic multimedia applications.
You can make this object interactive by enabling the actions.

Glow/Drop Shadow

This will create a new object based on the parent object (bitmap with one color, transparent, text or rectangle).
The Glow/DS object will be placed behind the parent object.

Tip: Glow/DS object is a bitmap object with alpha transparency map.

You can change the color of the Glow/DS object at any later time by opening the properties - changing the color
in color box and pressing Fill button.

Don’t check the Transparent Color check box !

Wizard — You can easily make an object that will glow if the user moves the mouse over the object. Select the
parent object (for example the Text), click the Wizard icon on the Toolbar and select «Glow on mouse move».
Now test the page and move the mouse over the object. The object will then glow

Label

String represents the new object.

Group with parent

New object will be grouped with parent after the new object is created.

Opacity

0 — 255. You can make Glow/DS more transparent by selecting a value less than 255
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Color
Color of the result Glow/DS object can be set later — see the TIP
Orientation — Offset X, Y

Glow usually has the position 0,0 relative to the parent, and Drop Shadow is usually shifted a little bit to
the right — bottom

Feather
How much diffuse will the new object have.
1 — the Glow/DS is almost sharp
Bigger number — more blur

Direction

Direction of the diffusion
Windows Metafile
Windows Metafile (WMF) format is very popular vector format. You can export vector graphics (for example from
CorelDraw) into the vector format. Metafile format can be scaled without loosing the quality. MMB also has
support for this format. In this version there are some restrictions: Metafile object cannot be active, it doesn’t
even have properties.
To place metafile objects on the screen:

1)) Select Metafile from the Object menu.

2.) Draw a rectangle on the screen, then the Open dialog will appear.

3.) Select .WMF file.

4)) Resize the rectangle to desired size.
Optimize the Speed and Colors
Crop the Images to the size you really need. Put as much bitmap graphic as you can into the background — the
background image redraws much faster than other objects. The tool Combine objects with background in Arrange
menu can help you. Big images with alpha transparency can slow down the application
For 256 colors — you have the palette.bmp file inside the Palette directory. You can use this image to extract
palette inside your graphic editor. All your graphics should use colors from this palette. Convert your pictures with
your graphics editor to 8 bit with using this palette.

For Corel Photo Paint there is already palette prepared inside the MMB’s Palette directory.

Reduce the size of the project. Click Reduce size from File menu. This will remove all unused temporary bitmaps
from the project.

Crop

Cropping cuts away rectangular areas on an image without affecting the resolution or dimension of the area that
remains.
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To crop an image:

1)) Select image object.
2.) Select Crop from menu Effects
3.) Draw rectangle inside the image.

You can Restore the original image by clicking Restore Original in menu Effects.
If you resize the cropped image, the original image will be restored. If you are satisfied with your new image then
you can apply «Make new original» from menu Effects. After that you can resize the new, cropped image like it
was the original image.
Make New Original
Bitmap images leave original image as a temporary. Whenever you resize the image, the original image is
resized. This preserves the best possible quality. The same works for cropping and Tile - the full image before
cropping or tiling is still remembered. If you resize the cropped or tilled image — the original image will resize
instead. Make new Original replace the temporary original with the current image. Then you can resize tilled
image or cropped image like you would do with normal image.
Tile
To tile the image:

1)) Resize image, It should be bigger than the previous.

2.) Click Tile in menu Effects.

3.) To apply Tilling you should use Make new Original.Otherwise after resizing the original image will
be restored.

Sparkles

Sparkles works best on dark background.

Reduce Size ( File Menu )

Resizing bitmaps and applying effects will create temporary bitmaps inside the project. Those bitmaps are not
necessary for distributing and removing them can significantly reduce the size of the project. You should use this

command if you are resizing the bitmaps or using effects before you distribute the files.

How To Work With Hotspots

Create Hot Spots
Hot Spot is an active object.
Hot spot is an invisible area you can define on the screen where your viewer (user) can click or move mouse to

make something happen. The area could be around a word, on the image etc. Hot spot is invisible to the viewer.
However, in the designer you see hot spots as an area with a dashed border.
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How To Work With Video

Video Import

This dialog imports the AVI file and allows you to grab the frame to represent video on the screen if this is not
playing the Still Image. Just play or skip to the frame you would like to use as a still image and press OK. Unfor
tunately capturing the still image from video doesn’t work under Windows 98. If you are designing the project
under Windows 98 you have to put some other bitmap object over the video object. For playing the project there
is no difference. | believe this is a bug in Windows 98, because all other capturing software has the same result —
cannot capture video frame under Win 98. (Hyper Snap, Striplt etc...)

Video Object

In order to play, stop or control the video, you have to place other controls on the screen with assigned Interac
tion with other objects and Video» action.

Tip: Wizard can insert video buttons for you.

After you create a video object, select it and click on wizard. Select «Create video controls>.This will create a
few bitmap buttons attached to this video object.

Version 3.1 has also MPEG and VideoDisc support. Remember this is done by MCI — build-in in windows — and
using directly device drivers. Since many user can have many device drivers — itcould happened some user
might not be able to play MPEG or VIDEO disc if they don’t have driver for it. Also you might try to load MOV
(Quick Time) video as well using Video Object. Just type in the Open dialog box *.mov and press enter. Here is
even stronger warning — you have 50% chance your system (driver) supports MOV, because this is format of the
Apple — the Windows enemy.

The AVI is the safest and sure way in Windows — this is supported in any versions of Windows. It is MS favorite
format.

AVI File

Video is an external file, it will stay outside the mbd file. It is essential to specify a relative path to the file
using <SrcDir> or <SrcDrive> commands in the path. You can do it later for all objects with «Replace
Path» in Project menu. More about relative paths in External Commands and Page Actions topic.

Hide Still Screen

Video, if it is not playing is represented on the screen by the still image. However you can hide this still
image.

Sound
You can disable sound if the sound channel exists in the AVI file

Note: AVI Audio plays through the standard audio output and it cannot be played at thesame time with
DirectSound channels.

Be aware!, video with sound will shut down DirectSound Channels and any backgroundmusic will stop
playing.Shortly, the sound of video cannot be mixed with background sound.

Speed

MMB allows you to play video at any speed. The default value (normal speed) is 1000. Less than < 1000
, and the video will play slower and in reverse.
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Loop
Video can play in the loop until the user triggers the STOP action .
Save Still

Maybe you would like to save the still picture for the future or to use it somewhere else. This will be
handy.

Load New
Load new AVI file or reload the old one and select different still image.

How To Work With Sound

Sound Actions

Moving the mouse over the object or clicking on the object can trigger a sound action. The supported files are
WAV files. Wave files are external files and are not included in the MBD file. You have to provide the relative
paths to the .WAV files. See comments in External Commands All sound actions are in Channel 2 if the viewer
uses DirectSound or in the standard audio output without DirectSound. Direct sound allows the user to hear
sounds without interrupting background music.

The On Click section can play instead of a Wave file the Audio track from Audio CD or Mixed-mode CD. To use
this function you will write instead of wave file name CD Audio command.

Commands
CD:TrackNumber

Will play desired track number. Note, if you're using Mixed mode audio the audio track will starts from 2.
(example CD:2)

CD:STOP

Stop playing

CD:PLAY

Start Playing — use after CD:PAUSE or CD:STOP

CD:FW

Play next track

CD:BW

Play previous track

CD:PLP

Play or Pause (the same action can play or pause playing)

You can use Script to do the same — using CDAudio commands. As you can see you can build your own little CD
player with Multimedia Builder.
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You can use also embedded wave files by writing the name or by clicking on the Embedded wave button. The
Embedded Wave Dialog Box will appear where you can add new wave or select existing wave.

Embedded Wave
Embedded waves allows you to add small sound into the project without having external files. This is great for
Actions — sound on button click etc... Don’t put music there — it will make the project file very big. The big

files should stay external!

How to use it ? Just load some wave, give it a name and then just use this name instead of the path in your
sound action or PlayWave script commands.

How To Work With Script

Script On Page Start

Any page can on start trigger some actions using the script language. You can of course change or create any
variable.

Example:You write on first page script:
NextPageAfter(30000)

If user doesn'’t click on anything after 3 minutes (30000 milliseconds) The next page will appear. You can create
some small animations using just couple of hundred milliseconds.

Script Language

Variables

All variables are global — they are valid for all pages.

The variables are internally float (3.1415) not integer (3)

You don’t have to define variable — all variables have default value 0.
Example: A=A+1

Arrays

Variables can be in arrays:

Example: Al1]=0
A[b+1] = A[b]

You don’t have to declare the arrays and arrays can be also negative
You can use the basic operations * / + - etc...
Boolean operators = < > & |
Constants And Predefined Variables
There are 2 constants:
‘true’ — has value 1
‘false’ has value 0

ScreenWidth
ScreenHeight
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Random Function

RND(Maximum)
Will return random integer number in the range 0 ...maximum

This you can use for jumping to the random page etc...
Example: A = RND(50)+1
The IF Statement

The if statement controls conditional branching. The body of an if statement is executed if the value of the
expression is nonzero.

expression can use any combination:  a<=b; a<>b; a=b; a=>b; a<b; a>b

The keyword end must close the inner code.

Example: A= A+1
If (a>4)
Show («text1»)
Show(Rect1»)
end

You can have if statement nested inside other if statements — but don’t do it if you can avoid it — the code will be
messy

Important — there is no else command, you have to make another if statement instead.
For — Next Loop

The syntax is typical Basic syntax
TO DO: Enter topic text here!

Example: fora=1t05
next a
Script Object
Script Object is non active object with only script inside. It is not visible on runtime. The Script Object can have
assigned keyboard shortcut so whenever user press the keyboard shortcut the script will run. This will allow to

create applications without mouse, or with hidden keyboard commands (exit, special page etc..)

In order to use the shortcut option check «Run Script by Pressing» and specify the keyboard shortcut — any
combination of a character, shift, control, alt.

(You can have only Shift, Control or Alt without any character) In the combo box are special keys like up
down,home ...

Script Wizard

Script Wizard will help you to write script actions without remembering the keywords. It will not help you to add ‘if’
command or variables.

Editor

Editor for Script language.
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External Commands And Page Actions

External Commands And Page Actions

You can use External Commands to launch an executable when your viewer clicks on an interactive object (With
Enabled actions) For example, you can: Run another project. This is a special action. It can run another MBD file
project in the same window (like anotherpage) or in a separate window. If the Second parameter is
NEW_WINDOW, the MBD file will be in a separate window. If the second parameter is THIS_WINDOW the new
MBD will be in the same frame — the user will think it is just another page.

If your project has a lot of graphics, it's a good idea to separate pages into different MBD files.Multimedia Builder
is designed primarily for small projects — like Autorun Browsers etc. You can create bigger projects, but you have
to have different pages or groups of pages in a different MBD file, otherwise the MBD file will be very large.

Do not provide a fixed path unless you're certain that your application will reside in a specific directory on your
viewer’s system.

Provide a relative path. The path is relative to the location of the MMB player on your viewer’s system. Use the
<SrcDir> or <SrcDrive> to tell MMB to use the actual directory where the player will be located on your viewer’s
system or actual drive.

If the user clicks on the object, this action can :

Start an installation, run any external program, jump to your web page, send an e-mail, open a docu
ment, display a help file, run another MBD file, Browse the CD, etc...

Move between pages of the MBD project
Exit
TIP:

You can change all paths to the relative paths at the end of development using Paths Replace in Project menu.
During development you can use fixed paths just to make it run. After you finish you can run Check & Distribute
files in Project menu and you will see a list of errors if you are using fixed paths.

New: In order to play videodisc etc.. the <CD> was added. This is the shortcut for the first CD ROM in users
system.

Page Actions - Only for Goto Page (Label) you have to specify the Label of the page (example: Page 1)
External Commands can Run a program, browse the disc, jump to a web page (you need to specify http:// and
URL), send an E-mail through default E-mail client ( you need to specify mail to: and the e-mail address) and
much more

External Command Example

The player is named AUTORUN.EXE and it is located on a CD inside the INSTALL directory. Let's say the CD-
ROM is drive D:\ on the viewers system.

The command: <SrcDir>\BIN\INSTALL.EXE will be translated into:
D:AINSTALL\BINVMINSTALL.EXE
And <SrcDrive>\VIEWER\VIEWER.EXE will become:

D:\VIEWER\IEWER.EXE
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Actions
Any one object can trigger (at the same time) three different actions:
Interaction With Other Objects And Video
Object can interact with other objects on the same page. (show/hide object, play video) on user actions:
Mouse move over the object.
Mouse click on the object.
Clicking the mouse on an object can trigger another action after the first one. For example, the first action can
hide a whole group and the second action can show a single member of the group.
For two actions with a mouse click and nested grouping you can create almost any effect. This action allows you
to add a professional look to your application (buttons glow when mouse moves over ...)

Sound Actions

Object can play a sound if mouse moves over the object and/or another sound if mouse clicks onthe object.
Multimedia Builder supports multiple channels, so you can still play a loop in the background without interruption.

Finalize Projects

Check Project And Distribute Files

At the end when you finish designing the multimedia application you would like to create distribution of your files.
This function can help you create a proper distribution.

Distribute Project

You have to select the location where you would like to copy all necessary files.

Select the location with the Locate button. The standard windows dialog will allow you to create a new
directory if you'd like.

Player

Today 95% of users have DirectSound installed and in the near future everybody will have (it comes with
the new Windows 95 and Windows 98). But still, to be sure — MMB has two players — for DirectSound
and without DirectSound.

Standard

Use Standard if you don’t use any sound at all, or use only Sound Actions if you would like to save some
space.

Auto

If you use background music, use Sound Action, the best choice of these options. Auto will copy both
players and the file that will launch the proper player regarding the users system.

DirectSound Only

Use this option if you need to have only DirectSound player. Be careful — users without DirectSound will
not be able to play your application at all!
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Checking The Project
This tool checks the project against fixed paths for WAVE, AVI and other external files. (See comments
about relative paths in External Commands and Page Actions ) You can create a distribution even if you

have errors. You will be able to play the application, and you will only have problems with external files
with fixed paths.

Resizing bitmaps and applying effects will create temporary bitmaps inside the project. Those bitmaps
are not necessary for distribution and removing them can significantly reduce the size of the project.

Compression

For distributing files on Internet or if the requirement is the size of file you can use powerful
compression. If you don’t have the problem with space, you should select uncompressed — the
project will load much faster then with compression. The compression will change the quality.
The significant quality change can be seen after Good Compression. Only one compression
doesn’t change quality — ZIP (100% Quality) If you want to compress files, but you don’t want to
create *exe files (for example to send mbd to user gallery on Internet) you can use from menu
File — Compress & Export instead.

Stand Alone

Standard MMB output is the player and the MBD data file. With Stand—Alone checked, the
compiler will produce only one .EXE file — the MBD data file will be linked inside the .exe file.

Important Note: Check Project and Distribute files doesn’t copy the external files (WAV, AVI or
other externals) to the distribution location. (They could be very big!) You will be informed after
you press the OK button.
In order to finish distribution of the files, you have to press OK.
The result message will pop-up.
Paths Replace
Wave files, AVI files and other external files (setup files etc..) are not part of the MBD file (they could be very big)
and they will stay separate. It is very important they have paths relative to the player on the users system, not
fixed paths. (See comments about relative paths in External Commands and Page Actions ) This tool allows you
to change all paths in the project at once for Commands, Wave files and AVI files.
Search String
The string that will be replaced. Search for common strings, for example C:\\WAVES
Replace With
Replace strings with this for example <SrcDrive>\WAVES
Replace Whole Path
Whole path to the file will be replaced. Great if you don’t have sources with some part of the path

common. (If you use sound files from all disks on your computer but on distribution disk have to put them
on one directory)
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Example: In project you use Wave files C:\Windows\sound.wav
D:\MSOffice\Ppoint\beep.wav

We put Replace With string: <SrcDir>\WAVE

Check the Replace whole path and press Replace All

The result will be: < SrcDir >\WAVE\sound.wav

< SrcDir >\WAVE\beep.wav

Now you have to copy all wave files to your distribution into the directory WAVE

Replace All

This is the actual button to make the replace action. You cannot cancel this operation, soit is a good idea
to save the project before.

Note: The commands, waves and video files are separate files because it is good idea to put them
separately on the distribution disk.

Separate Files Example
All external files (Setup, etc.) will be put in directory <SrcDir>\BIN
All wave files we will copied to <SrcDir>\Waves
And all videos we will copied to <SrcDir>\AVI
The <SrcDir> will be replaced at runtime with the actual directory of the player.

Basic Functions - The typical function has syntax:

Function(“parameter1”,”parameter2")
There are functions with zero, one or two parameters.
Hide(“OBJECT”)
Hide object or a group of objects
Show(“OBJECT”)
Show object or a group of objects. If you show animated gif the gif will start animate from the first frame.
Invert(“OBJECT”)
Show or hide object or group of objects. If the object/group was visible before this will hide it and opposite.

VideoPlay(“VIDEO OBJECT”)
VideoStop(“VIDEO OBJECT”)

Play and stop video (AVI) object
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RunMBD(“PATH TO MBD”,”PAGE LABEL”)

Run an another mbd project in the same window. You can specify a Page where the new project will start — but
you don’t have to. This is very important command for creating big applications. You will put different blocks to
separate mbd files and instead of moving between pages you will move between files. This allows you to make
really big multimedia without memory problems — the old project is deleted from memory as soon as new one is |
oaded.

Also if you using Full Screen Background (Kiosk)- this allows you to change the background bitmap jumping to
another file and loading the background from there. Don’t forgot to use <SrcDir> in the path !

Run(“PATH”,"PARAMETERS”)

Run external programs. You can run file viewers, setup utilities etc..Also you can run another mbd project in
different window. Even if you create stand alone file (autorun.exe) — call the same file with another mbd file as a
parameter. (<SrcDir>\autorun.exe <SrcDir>\otherfile.mbd). This will pen another project in different window —
with different size and settings)

FirstPage()
LastPage()
NextPage()
PrevPage()

Page(“PAGE LABEL”)

Page commands — jumping to different pages within the project. In the Page command you can specify
LASTPAGE instead of page name. This will jump to the last viewed page within the project.

Exit()

Quit the application immediately.

Minimize()

Minimize the application. This is the Minimize button action.
ExitTimer(“MILLISEC”)

Exit application after number of milliseconds. Be aware the PageTimer will cancel this command.Also clicking on
any active object will cancel the command — this is important — you can provide user with button to go back not
to exit. With this command you can wait until sound will play, or display your logo for few seconds etc...

PageTimer(“MILLISEC”,”PAGE”)

Got to a page after number of milliseconds. If you don’t specify the page — the next page will be taken. You can
also use commands instead of page label: THIS _SCRIPT — will just run the script on the same page THIS _PAGE
— will start the same page again. The difference is — page start will put all objects to its default stage and it will
look also for background music — and then it will run the script.

Important; Clicking on any active object will cancel the command ! Using another PageTimer or ExitTimer will
cancel the previous PageTimer. With this you can make the self running presentation — if user doesn’t click on
anything in few minutes MMB will go to the next page. If user click on some active object, the page timer will be
canceled (User wants to stay on the page) and is up to you if you will leave it like that or start PageTimer again
on Button click. For example you can make the portfolio show, where each item is on different page and if user
wants to stop the show he will just press the button Pause.

DisplayValue(“TEXTOBJECT”,VARIABLE”)

Display an integer part of the variable in some text object. Good for counters etc...



Message(“ANYSTRING”,VARIABLE”)

Mostly for debugging. You can make pop-up the message with an integer value of some variable.
Return()

Return from executing the script. You can use it in if — end statement.

AGifPlay(“ANIGIF OBJECT”)

AGifStop(“ANIGIF OBJECT”)

AGifReset(“ANIGIF OBJECT”)

Animated Gifs commands. The play will play anigif from the actual frame, the stop will stop the animation. The
reset will set the actual frame to the first frame. How the anigif will animate depends on the Anigif properties.

RunScript(“OBJECT”)

Run script of some other object. The best would be to run Script Object script so you can build some kind of

global functions. However you can run script from any object — the Mouse Up script will run. You can run the

same script — and you will create recursive calls. Unless you are sure what you are doing don’t use recursion.

ScriptTimer(“OBJECT”,”"MILISEC”)

Run script on object or Script object after a number of milliseconds. (See RunScript). Good for hiding some
message after few seconds etc...

Sound & CD Commands

Wave
WavePlay(“PATH TO WAVE”,”command”)
WaveStop()
Wave comands. Play or stop external or internal (embedded) Wav file.
In the command you can specify LOOP, this will loop the wave until you use WaveStop().

Be aware looping works best with DirectSound. Without direct sound you will have gaps between the
loops.

To use embedded wave just put the name of the wave without any path.

The names of embedded waves are (and must be) without extension.

MP30pen(“PATH TO MP3”)

MP3Play()

MP3Stop()

MP3Pause()

MP3 commands. MP3 file must be external. You have many ways how to play MP3 file (External
Commands and Page Actions — there you have also MP3 FW and BW, From Page properties, from

Sound Actions, from script) If you use empty string in MP3Open, the Open file dialog will appear. Look
for CBK Obijects to see how to get feedback from the mp3 player.
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CDPIlay()

CDStop()

CDPause()

CDTrack(“NUMBER OF TRACK?”)
CDFW()

CDBW()

CDPlayPause()

CD audio commands. Be aware if you making Mixed-mode CD’s the first track has number 2 (the 1 is the
data track)

In CDTrack you can also use the variable: CDTrack(“a”)

MidiPlay(“PATH TO MIDI”)
MidiStop()
Midi commands. MIDI files are external files.
OctaMed
OMEDOpen
Open and Play OctaMED module File.
OMEDPIlay
Play opened OctaMED File.
OMEDStop
Stop opened OctaMED File.
PlaySound
Play all supported sound formats. The format depends on file extension. The command will first stop all
currently playing sounds. You can use it after the FileOpen command passing the
<File>PlaySound(“<File>");
Volume
VolumeUp
Increase Master Volume by 5%

VolumeDown

Decrease master Volume by 5%
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Print Commands

PrintText

Print Text Object. First parameter is the text object (Text, or Paragraph Object) In secondparameter you can
specify additional parameters. Normally the text will be printed with the default print font (the optimal font and
size for documents).The FONT_FROM_OBJECT parameter will print the text with the same font like in the
object.

PrintPage

Prints the full page - what you see is what will be printed

PrintRect

Prints only part of the page surrounded by any Object Rectangle. This object can by anything and it doesn’t have
to be visible. It could be for example square on the background — everything what is inside the square will be

printed.

Both commands have another option Fit — this is the percentage of the fit to the page. Default (nothing) is 100
(means 100 %).

If you put 75 — it means the printed image will be just 75% of the width of the paper.
SaveVariable
SaveVariable
Save the variable in the registry under the Name identifier. Use LoadVariable to load the variable back.
LoadVariable
Load the variable from the registry Name.

Remember to set in General Settings the Registry entry: Check Save Last Position in Registry and set an unique
name of your application. Then uncheck the Save Last Position in Registry.

The variable will be saved in the registry under the:
Registry Name (From General Settings) + The Name from the Save/Load Variable command
You should use it like that:
You have variable HiScore
Whenever the variable is updated use:
SaveVariable(“High Score”,”"HiScore”)
And on the beginning of the program use
LoadVariable(“High Score”,”HiScore”)

So anytime you start program the HiScore will be loaded from registry. If you use “High Score” name in some
other application, you really need to change the registry name in the General Settings.
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MP3 List Commands

You have your “internal” mp3 list where you can add mp3 files or import files from external list.
MP3ListReset
Delete All items from internal MP3 list.
MP3ListAdd
Add Mpa3 file to the internal list
MP3ListPlay
Play the internal list of MP3 files
MP3ListNext
Play the Next song from the internal MP3 list
MP3ListPrev
Play the Previous song from the internal MP3 list
MP3ListLoad
Import the internal List from external list file. This file is just list of mp3 files.

For example :

<SrcDir>\zabka.mp3
<SrcDir>\sunshine.mp3

If you don’t specify any virtual directory with <SrcDir>, <SrcDrive> or <CD> the path to the list will be inserted
there.

MP3ListRND
Randomize existing virtual list.
MP3ListEdit

Open special window that enables user edit the virtual MP3 list, save to disk or load it from disk.
The adding new items is very easy - just drag and drop mp3 files from explorer to this edit window.

For sample about MP3 Lists see mp3list2.mbd

External Image Commands

ViewJPG(“PATH TO EXTERNAL JPG”,”CENTER”)

This command opens external JPG file in new view window. With optional CENTER as a second parameter the
window will be centered on the screen.

This command is great for Image disks - where user clicks on a small image in the mbd projects and the full
version will be opened in the separate window.

Clicking on the window will close it. The window will remain its position for next time if no CENTER command is
used. 29



Replacelmage(“BITMAP OBJECT”,”PATH TO EXTERNAL JPG FILE”)

This command replace the current image in the Bitmap Object from external JPG file. The image Object will be
resized to the size of new image.

This is great if you need to show many big images in the MBD project. For example catalog of houses. You don’t
have to put all the images in to the MBD objects (This will make it huge and you will need to split it to multi mbd
files). Instead just create one page with one Bitmap Objects and the commands will replace the image in that
objects from external jpg file. Like that you can easily create huge image kiosks or catalogs.

MCI Commands

MCICommand(“MCI STRING”)

This will send a string to a device. The string will tell the device what to do. With this command you can access
the devices for playing MPEG, video discs, record sound, play animation etc..

You can use <SrcDir>, <SrcDrive> or <CD> in the string. Also use <This> with the parent comand to tell the
device the MMB window will be the parent.

Here is a small sample to play MPG movie inside the mbd project in the position (100,50,100,100):
MCICommand(“open <SrcDir>\sample.mpg alias MPEG style child parent <This>")
MCICommand(“put MPEG window at 100 50 200 200”)

MCICommand(“window MPEG state hide”)

MCICommand(“play MPEG”)

For a complete understanding and the syntax, consult Microsoft Documentation. This is accessing the device
directly — be prepare for crashing if you are going to experiment.

OpenFile

Opens The File Open Dialog Box. The selected file will modify <File> shortcut. The Filter: (If you are program
mer you will be familiar with the format.

Example MPEG Files (*.mpg)|*.mpg|All Files|*.”||

This will create in file open dialog box two choices MPEG Files and All Files. Note the | characterbetween the
items and the double || on the end. The format is : Text displayed in The combo box |associated extension||

The other parameter is the default extension.

Example *.mpg

After using this command you can use <File> whenever you will use <SrcDir>
FileString

Searches <File> string for the first match of a substring. You put the substring (for example): .wav
If the <File> has substring ‘.wav’ in its string the variable (Second Parameter) will become 1

InstallFont
If you using some font which user might not have on his system — it will be substituted with other font — that’s not
the effect you would like. Using InstallTTF you can temporary install your font on users computer. This font will be

uninstalled after you exit the application. The example: Put your funny.ttf font on the distribution CD and on the
beginning of the application call:
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InstallFont(“<SrcDir>\funny.ttf”)
FileExist(“PATH TO FILE”,”VARIABLE”)

Tests if external file exists. If yes the VARIABLE will get value 1 else 0

Credits
Thanks to all of you who sent me any suggestions or just nice words.
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Edd Twilbeck - for his ideas and encouragement and of course for the logo.
Derrick Yohn - for making this web space reality not just my dream.

Artur Svarc - for his beta testing.

Ronnie Toon - for sending me pages and pages of great suggestions.

Pierre Labelle - for Helping me with the Help File.

My great wife Zuzana - for her endless patience (she really hates computers now!)
and many other people...

Mike Board - for the PDF format manual you now hold in your hands.
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Extra CD Info

CD EXTRA is the latest type of ‘Enhanced CD’. Enhanced CD is the umbrella-name given to all types of CD audio -red book
- which have been combined with CD-ROM - yellow book - data. There are three main types of Enhanced CD:

Mixed Mode and Pre-gap CD Layout Mixed mode or track one CDs put the yellow book data in before the first audio track
of ared book CD. The first audio track then becomes track two. If you play this type of disc in your CD player you must ‘skip
track one’. Mostly the data will not be interpreted by the audio player and track one will be silent. However, some audio
machines will play the data - causing a noise which is dangerous to both speakers and ears.

Pre-gap or hidden data CDs put the yellow book data in index zero of track one on a red book CD. The audio index then
starts in track one of track two. Most audio CD players will ignore the data, many (but not all) CD-ROM drives will find the
data. Itis theoretically possible for a person to ‘rewind’ the CD into the data and create the same sound problem as with track
one, although this is unlikely to occur by accident.

CD-EXTRA Layout CD-EXTRA has an official definition (blue book) and stores the red book audio in the first session on the
disc and the yellow book data in a second, completely separate session. Since an audio player is a single session machine,
it is only able to access the first (audio) session. Most new CD-ROM drives are multisession which means they can see the
data session as well as the audio session. CD-EXTRA was originally known as CD-PLUS. Although CD-EXTRA solves most
of the problems encountered with the earlier Enhanced CDs, it is a new format and not immediately supported by all CD-
ROM drives.

For MMB users: Using Mixed mode the first audio track is track 2. Using CD_Exttra the first audio track is track 1!



Loading One MBD After Another Using Timer

| want to have a project that only plays an AVI as an intro before the main project. I’'m now running the
intro.mbd that has the video. The only page has a script as follows:

VideoPlay(“Video”) Exit timer(“15800”) RunMBD(“<SrcDir>\Programs\Mainproject.mbd”,”Inicio”)

The problem is that the Mainproject starts running before the AVI finishes. Is there any command to make
the Mainproject waits until the video is finished?

Use this : First create a new script let say named”Script” then put this in the first page:

VideoPlay(“Video”). ScriptTimer(“Script”,”15800"). and now go to “script” and put inside

RunMBD”(<SrcDir>\Programs\Mainproject.mbd”,”Inicio”).

This should load the new page after 15800 ms.



Protecting An Application Until The Sale

I have created my project for some company, and it works fine but when i gave them the software the first
thing they did is they checked on the version of the project and by whom is it made. They found the
multimedia builder copyright thing whne they clicked on the right button over my project exe file and they
were telling me that this is not my project and from that mmb and i tryied to explain them that i used the
mmb software to make the project but they didn’t want to listen and they reject the project. | spent a lot of
time working on this project and i hate to see it fail. The question is : when you click on the right button
over the exe file made by mmb you will see something called version you click on that you see mmb
copyright , how do i change that to my company name if possible if not how do i erase it.

Response #1
1.) ALWAYS use Compress & Export, thus allowing you to use a password so others cannot edit the file.

2) Rename your files suffix ( extension ), as Ronnie does with his Toon-Classix files. Of course as he also says, you
have to use a script telling to run the program that has that suffix.

3.) Use a “Splash Screen” somewhere in your project, maybe that will help convince the user that it was you who at
least partially created the program file(s).

Response #2
1.) A splash screen with copyright info. For example: put “©1999 Marc Jutras” on every page of the project.

2.) Prepare a sample project, a general one, not one made for the guys you’re meeting. Tell them you produce that
kind of stuff and that you can adapt your product to their needs.

3.) Make your presentation and DON’T leave a copy of your demo. If they want to see it again, go back. Anyway,
you'll be able to answer their questions, defend your ideas and help them find solutions for their needs.

4.) If you must leave a copy, make sure that you can prove your copyright in court. In your case, if your “customer”
comes up with a software pretty much identical to yours (functions), you could bring them to court.

Response #3

Use a background in the application that includes greyed letter saying something like SAMPLE. They have to buy full app to
get SAMPLE words removed. Artists do this.



Transition Tips

Tip #1 - Smooth Non-Pixelated Transitions
If you want ‘smooth’ edges... the transition image must be identical in size to the project size.
Tip #2 - “Partial” Transitions Using Color

Better still, although the requirement is black and white (with gray scales).. try putting some other colours/images in the
transition effects and voila.. you have transition effect on a ‘partial portion’...



Running Applications With Pauses

I’m trying to have actions done with pauses in between. In other words: Display an image, then display
another image, hide the first image, then show a third image, hide the second image and so on...

You have to use Script objects.

Here’s an exemple. Let’s say your “slideshow” is composed of 2 images and a button to start it and you want the slide
show to LOOP. You must add a script object for each image (2 script objects).

START BUTTON’S SCRIPT
RunScript(“ScriptObject1”,”)
SCRIPTOBJECT1’S SCRIPT
Hide(“Image2”) (note: this is for the loop) Show(“Image1”)
ScriptTimer(“ScriptObject2”,”10000") (note: 10000 milliseconds = 10 sec)
SCRIPTOBJECT2’S SCRIPT
Hide(“Image1”)
Show(“Image2”)

ScriptTimer(“ScriptObject1”,”10000")



Looping Background Sound Across Pages Using Variables

I’m working on a corporate CD and | want a background sound to loop through-out the whole program.
When | go into the properties | see the loop mp3/sound, | place a sound. But my problem is after | go
through each section, when it returns to the main menu the sound restarts!!! | want the sound to con-
tinue rather than to restart all the time.

How about using variables say.. like [SoundON] below.
PAGE1 ====== if (SoundOn=0) Page(“PAGE2) end

PAGE 2 ====== SoundOn=1 ..... Page(“PAGE1”)



How To Embed A MOD Sound File

Here is what i am doing

Create a new doc

Embed a sound - street.mod - it is in same path as the doc

Page properties

| chose the mod - in this case street.mod

I run the ap and get this - “an unnamed file was not found”

Can someone tell me step by step how to embed and and make a mod play?
Go to project tab and click embedded sound

Find the mod file and click ok

Now go to the property page in the sound section

Write the name of the mod file like “street” with no extension - nothing - just the name of the file and check the loop
option if you want the file to loop

NOTE: MOD files are case sensitive - if the MOD is Fred.mod type uppercase “F”red.mod not fred.mod or it will
not play




How To Embed A EXE File

Go to path and click embedded file
Then from there choose the browse icon and find your file and click open or ok
Then the file should be there and to execute the file

Under the action of a button choose Run Program and under command put : <Embedded>\filename.exe.



Hiding AVI Window After Video Plays

I’'m launching the AVI file as a link to a text message. The video runs fine when | click on the text link,
although after the video runs the area where the video ran remains black, covering a portion of my
presentation page. Is there a way to tell the application to remove the video player screen ( the black
square area) after the video runs?

Go to the properties of your video and find out how long is your video in time manner

For example “30 sec”

Then go to that link say your text where you click to launch the video and put this script after video play script
HideScript(“video”,”30000")

You know use the script timer option and put the exact timing for the video that way when you click on the link the video
will play and it will stop after 30 sec

NOTE: don’t forget that 30000=30sec.



Choosing MIDI File ( Or Any Othre File Format ) From Directory Then Playing

I am having problems getting midi files to play just like the mp3 files. | can get one file to play, but i
cannot open a file from a directory list and then select file to play.

The solution is as follows:
SELECT BUTTON ============= QpenFile(“MIDI Files (*.mid)|*.mid”,”*.mid”) Result = 0 FileString(“.mid”,”"Result”) if

(Result=>0)
MidiPlay(“<SrcDir>\<File>") end



Changing File Extensions So Only MBD Can Open Or Edit Them

For my company i am gonna make a multimedia cd . now its gonna have more menu’s i want to do them
in diferent projects and if i click a button it starts another mbd project . that is not hard to do but if i start
different projects they are on cd as mbd file . now what i wanna know is if it is possible to have another
extension or is it posible to save the files so that they can not be edited by mmb again and only can be
started from the menu?? Simply rename those *.mbd files to whatever extension you want.

For example, you can use ‘RunMB’ command to call the file and instead of “xxx.mbd”... specify “xxx.abc”
And because the extension is ‘abc’..it’s not associated to any program (or well..depending on system..)

Addendum

When you rename a file in Explorer, say, from SAMPLE.MBD to SAMPLE.ABC, the filename is changed BUT the actual
filename now becomes SAMPLE.ABC.MBD

1. What you have to do is go to DOS SHELL, rename the SAMPLE.MBD to SAMPLE.ABC
2. Then EXIT and return to EXPLORER.

Now change the filename (if you wish) to something more legible like ‘SAMPLE PROJECT.ABC’. Make sure the RunMBD
command is used, and the script like what | mentioned in earlier mails.

Or..

1) If you have a recent version fo window, click the start menu, than settings, than click folder options and click the “View” tab
and scroll down to an option about showing the file extensions of files within window,s and BINGO, the extensions will show
up winthin Explorer and allow you to edit them

2) If you have the FTP Client WS_FTP just open that, don’t connect to a server just click cancel, then find you file in the left
hand panel, select it and click rename and BINGO once more, you can change the file extension as well as the name.

Side Note:

When a external program is run using the ‘RUN” command, it doesn’'t matter whether the filename (or rather, the file
extension) is SAMPLE1.EXE or SAMPLE1.ABC Likewise, when MMB loads an external JPG file (heh... my *.sty is JPEG
and not BMP), it doesn’t bother about the file extension.

The ‘reason’ lies with the header of the target file. All JPG or BMP or even EXE has a header. For JPG... there’s something
like “JFIF” and for EXE there’s “MZ”. Just use a simple editor, say, DOS EDIT to open a file.. and you’ll see the header. If you
rename an EXE file to SAMPLE.JPG and uses the “Replacelmage” command to try to open the file.. an error will occur
because it expect the header to be JFIF and not a MZ. MMB was developed to be more flexible (unlike some competitors
where WAV must be WAV, and MID must be MID) so that you can easily rename the extension of external files and yet
called them using the normal method. Look at my previous games (other than LOGIC CODE).. the *.bgs are actually MIDI

files!

Do expect 2 demo files from me in a day or two which will show you the trick/technique I'ved used for the 2 different
implementation concepts for my games. The ‘“1st generation’ one uses the RunMB to load modular games into the player.
It's all a visual trick. The LOGIC CODE is my ‘2nd-generation’ version which uses the ‘Replacelmage’ function to load
external Styles, much similar to WinAmp’s skin. What this means is with the availability of the 2 samples.. you can easily
create your own MMB version of WinAMP with user-definable skins!

For family albums.. you can have some fun say, a photo showing you and your family, with the backdrop image showing the
SAHARA DESERT. A button is displayed and when user clicks at it, it will load say, the beautiful skyline of SINGAPORE..
and so on. What'’s important to note is the file size of the album projectdoes not change as all external images are... external.

Special Thanks To Ronnie Toon



Forcing A CD Play Button To Play Only A Particular Track

In this example, you want to play only track 4 from the CD (Mixed-mode or CD-EXTRA) and then stop. The user can
replay the track as much as he wants by pressing the play button. Track 4 is 30 seconds long.

Why?
Let's say your page describes the content of that track. You don’t want track 5 to start on that page.
Create a PLAY button (or use the “Insert CD controls” wizard).

Note that you should only include PLAY and STOP buttons since the user is not supposed to
browse the CD.

Using the script wizard (“Action” in the button configuration window), determine the track you want your button to start.
In this example, track 4 ( CD Track(“4”) ).

Again, with the script wizard, choose for Action: Script Timer.

For Object, choose your STOP button.

Finally, set the amount of time to the exact lenght of your track (milliseconds).

So, if track 4 is 30 seconds long, the timer should be set like this:

ScriptTimer(“Your_Stop_Button”,”30000").

The entire script should like this in the small window: CD Track(“4”)

ScriptTimer(“Your_Stop_Button”,”30000")

The result of this is simple.

The PLAY button will start to play CD track 4, start a countdown of 30 seconds and then launch the script of your STOP
button which will stop the CD.

You can restart the track by pressing the PLAY button. Pressing the STOP button will stop the CD as well.
Here’s an extra tip...

Let's say you are creating a CD with many audio tracks and want to have one page describing each track.
Create a menu page.

On each “track page”, create a BACK button and add to its script the same action as your CD STOP button.
That way, if the user hits the back button while listening to the audio track, it won't play over the menu page.

You could also add the CD STOP command to the script of your menu page.



How Can | Change The ICON In The Standalone Executable Or Player EXE Files?

You can get several pieces of software that allow this, one of them being Microangelo 98 with this you can import the exe and
edit the Icon or insert a bitmap (or paste from the clipboard) into the space, at the moment Oscar has only got MMB set up
for 16 colour Icons, but this will change in the future.



How To Print A Page

In the Script choose PrintPage from the dropdown menu then specify the size you want to print it out:

PrintPage(“50”)



How To Print An Image

In the Script choose PrintRect from the dropdown menu then specify what you want to print and how much page width to use:
PrintRect(“Bitmap”,”100")

where | have used “Bitmap” you can place the name of any object or hotspot area / group etc.



Making One Application Play Inside Another

How to make a project play inside another project like you do? | had an idea for a presentation and would
love to make little projects to share and they could keep the player.

It's all a VISUAL TRICK... The TOONCLX.EXE is the main compiled MBD file, where the others are passwrd-protected MBD
files (using the RunMBD command to access). Likewise, you can have compiled EXE files and disguised them as DAT files..
as long as the project size is identical to all files. In my case, all TOONIES games have the same interface defined in the
MASTER page.. Well, the *.bgs is actually *.mid... and so on.



How To Loop An Embedded Wave File

You can set the Internally Embeded Wave file to loop continuously, Under ‘Page’ > ‘Properties’ where you can add a Wave

File (or external MP3) and check the LOOP box, now if you want to run the internal Wave all you do is leave the extension
off the name of the file that you have embeded.

For example: WaveName.wav has been embedded so you call up WaveName and check LOOP this will now repeat.



How To Print A Paragraph

Create a script under a button / hotspot and find PrintText from the dropdown menu in the script then specify the para-
graph object:

” 9y

PrintText(“MYparagraphobject”,”)



How To Play More Than One MP3

| created a text button. | went to its properties. Then, | clicked on the first choice of “Actions”. | chose
“MP3 Open” on “On Mouse Click”. And | only can select one mp3 file. So, is that any other way that | can
play more than one mp3 songs by just clicking one text button.

1.

Open Notepad. In Notepad type in the filenames of the MP3 songs you want to play.

Ex:

01.mp3 02.mp3 ... 10.mp3 etc

Save that file as ‘List.txt’'(or call it what you want). Bear in mind to check the paths to your songs.

2.

3.

Go to the properties for the Text Button & select the More Actions (Sript Language).

Select the Mouse Up window, bottom one.

. Select the Wand (Wizard).

. Under ‘Action’ go right to the bottom of the list & select ‘MP3ListLoad’.

. It will ask you for a source drive - so go to the directory where you saved ‘List.txt’ and open that, then click OK.
. Select another action. This time select ‘MP3ListPlay’.

. Click OK until your back to your project screen.

. Test the page, & click your Button. It should Load the PlayList, then play the songs you typed into ‘List.txt’



Animated GIF Splash Screen With Timer To Go To Next Page

GOAL: To have the first screen consist of an animated gif. Once 10 seconds have passed, the user is
automatically forwarded to the next page.

You can do your first screen, with the animated gif, and still have it change to the next page after 10 seconds.

What you need to do is lay it out, with the gif on the first page, go down to the page properties, (next to the test button), and
go to page script. Go to the little magic wand, and under action, go to PageTimer, in the “AFTER (ms)” put in there, 10000,
this will leave it up for ten seconds. The 300 that you had, would make it fly by, practically undetectable. Now go down to
Page Label, and type this - Page 2 (or whatever the page label is where you want to go).



Text-to-Speech

TTS has a big potential of the market’'s five major segments: education, disabled, computer interface, consumer and
telecommunications.

What is Text-to-Speech?

Text-to-speech is a process through which text is rendered as digital audio and then “spoken.” Most text-to-speech engines
can be categorized by the method that they use to translate phonemes into audible sound.

Why Use Text-to-Speech?

Text-to-speech should be used to audibly communicate information to the user, when digital audio recordings are inad-
equate. Generally, text-to-speech is better than audio recordings when:

Audio recordings are too large to store on disk or expensive to record. Audio recording is impossible because the application
doesn’'t know ahead of time what it will speak.

Text-to-speech also offers a number of benefits. In general, text-to-speech is most useful for short phrases or for situations
when prerecording is not practical. Text-to-speech has the following practical uses:

Reading dynamic text. Text-to-speech is useful for phrases that vary too much to record and store using all possible alterna-
tives. For example, speaking the time is a good use for text-to-speech, because the effort and storage involved in concat-
enating all possible times is manageable.

Proofreading. Audible proofreading of text and numbers helps the user catch typing errors missed by visual proofreading.
Conserving storage space. Text-to-speech is useful for phrases that would occupy too much storage space if they were
prerecorded in digital-audio format.

Notifying the user of events. Text-to-speech works well for informational messages. For example, to inform the user that a
print job is complete, an application could say “Printing complete” rather than displaying a message box and requiring the
user to click OK. (This should be used for noncritical notifications in case the user turns the computer’s sound off or is out of
hearing range.)

Providing audible feedback. Text-to-speech can provide audible feedback when visual feedback is inadequate or impos-
sible. For example, the user’s eyes might be busy with another task, such as transcribing data from a paper document. Users
that have low vision may rely on text-to-speech as their sole means of feedback from the computer.

Games and Edutainment

Text-to-speech is useful in games and edutainment to allow the characters in the application to “talk” to the user instead of
displaying speech balloons. Of course, it’s also possible to have recordings of the speech.

Text-to-Speech Voice Quality Most text-to-speech engines can render individual words successfully. However, as soon as
the engine speaks a sentence, it is easy to identify the voice as synthesized because it lacks human prosody — i.e., the
inflection, accent, and timing of speech.

Application Design Considerations

Using Text-to-Speech for Short Phrases An application should use text-to-speech only for short phrases or notifications, not
for reading long passages of text. Because listening to a synthesized voice read more than a few sentences requires more
concentration, a user can become irritated.

Presenting Important Information Visually An application should communicate critical information visually as well as audi-
bly, and it should not rely solely on text-to-speech to communicate important information. The user can miss spoken mes-
sages for a variety of reasons, such as not having speakers or headphones attached to the computer, being distracted or out
of earshot when the application speaks, or the user may simply have turned off text-to-speech.



Avoiding a Mix of Text-to-Speech and Recorded Voice The synthesized voice provided by even the best text-to-speech
engine is noticeably different from that provided by a digital-audio recording. Mixing the two in the same utterance can be
disturbing to the user (and usually makes the text-to-speech voice sound worse by comparison). For example, to have an
application speak “The number is 56,738,” you should not prerecord “The number is” and use text-to-speech to speak the
numbers. You should either prerecord everything or use text-to-speech for everything.

Making Text-to-Speech Optional An application should always allow the user to turn off text-to-speech. Some users work in
environments in which a talking computer may distract coworkers or in which privacy may be important. Also, some users
may simply dislike the sound of a synthesized voice.

Speech synthesis: Creating a synthetic replica of speech. Machine-generated output, simulating speech either electronically
(by modelling changing resonances of the vocal tract) or by splicing together samples of speech.

Phoneme: Basic sound unit of speech. The phonemic repertoire of a language includes all the sounds a speaker will use. For
example, English has 44 phonemes.

Text-to-Speech in Multimedia Builder

Multimedia Builder from version 3.2 will support Microsoft TTS engine. You can let your application read any Text Object,
Paragraph or just simple say words and phrases.

MMB is one of the first Multimedia Authoring tools supporting Text-to-Speech.

TTS is be supported using following commands:

InstallTTS

Install MS Text-to-Speech Engine from specified path. The command first test the system if such installation is needed. If
user doesn’t have TTS engine installed on his system, MMB will very fast install it. You have to just put the TTS exe file on
your CD and the rest is very fast and automatic. If you planning to use TTS in your program for distribution you should call
this on the beginning of the program. If user already has TTS engine, the command will continue with no delay.

InitTTS

Initialize TTS engine. This could take a few seconds on slow computer so the best place is to put it on the beginning of the
program after InstallTTS command.

Say
Say the text.The TTS engine must be installed and Initialized.
SpeakText

Speak the text of any object which has text : Text Object, Paragraph Object, Button. The TTS engine must be Installed and
Initialized.

StopTTS

Stop what TTS is currently saying.

PauseTTS

Pause what TTS is currently saying, you can resume it by ResumeTTS command
ResumeTTS

Resume paused speech.



PitchTTS

The Pitch of the voice. (Frequency Hz) Between 50 - 200, default is 100

SpeedTTS

The Speed of the voice. (Words/minute) Between 30 - 450, default is 150

ALL FOR NOW
SEND
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MIKE IN TEXAS / MBDesign

dbeard@hotmail.com / pathways@door.net



